Experiment Number 3
Revised: Fall 2018

Using PLECS to Simulate Diode Circuits

Preface:

e Experiment number 3 will be held in CLC room 105, 106, or 107. Your TA will let you
know

e Preliminary exercises are to be done and submitted individually and turned in at the
beginning of class

e Lab Report to be done in Word Doc according to the format uploaded on CANVAS and
submitted by individual students at the beginning of the next class

e Be sure to include answers to Q1 thru Q7 in the Lab Report

e Tech Memo to be done in Word Doc according to the format uploaded on CANVAS and
submitted by individual students at the beginning of the next class

e Laboratory simulation exercises are to be done individually

e Review the guidelines for plagiarism to be aware of acceptable laboratory and classroom
practices

Objectives:

e Use PLECS tools to simulate the characteristics of the diode

e Use PLECS to model and simulate a half-wave rectifier

e Use PLECS to model and simulate a bridge rectifier

e While the laboratory notebook will not be turned in and graded for this lab, the specific
content indicated in red and the questions should be recorded to add in completion of the
Technical Memorandum.

References:

e EE 151 and EE 153 text. Cunningham and Stuller, Circuit Analysis, 2" Ed. (Houghton Mifflin
Company, Boston, 1995)

Background:

PLECS can be used to analyze the performance of nonlinear components. A diode is a two-
terminal device that performs differently under forward and reverse bias. Rectifiers are one of the
most common uses of diodes. They are used to convert AC waveforms to DC waveforms. This
laboratory will simulate the operation of a half-wave rectifier and a bridge rectifier. The half-wave
rectifier uses one diode and rectifies only the positive half of the wave. The bridge rectifier, or full-
bridge rectifier, uses four diodes and rectifies both negative and positive halves of the wave.
However, the half-wave rectifier is used when applicable because one diode uses less power and
is more cost efficient than four.



Preliminary:
Work on separate sheet of 8.5x11 printer paper and turn in at the beginning of the laboratory session.
e Consider a silicon (Si) pn step-junction at 300K.  Let the p-side be doped so that

Na = 10'®cm 2 and the n-side doped so that Np* = 10*®cm™. Note that ni (Si) = 1.5x10%
cm3. Calculate the contact potential Vo for this structure.

e For the diode circuit shown in figure 5, let the diode have an abrupt turn-on voltage of 0.7V
and a reverse saturation current of ~0OA and let the resistor be R=1.0kQ2. Show the load-line
equation for this circuit with variables V and I. Calculate the voltage across the resistor using
the graphical load-line approach for Vs = -10, -6, -2, +2, +6, +10V (show each calculation
explicitly). Put the results in a table with columns for Vs and Vr.

Equipment:

PLECS software package, an add-on to MATLAB Simulink program in the CLC

Experimental Procedure:

(Record specifics in the Laboratory Notebook)

1. Start MATLAB

2. Open a new Simulink window by clicking on the Simulink button. The simulink button is in the
top left of the MATLAB window. The Simulink icon is highlighted in Figure 1 shown below.
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Figure 1: MATLAB Start Page

3. The window that appears is called the Simulink Library Browser. This window contains every
component that can be placed into a simulation. The Library Browser window can be searched in
two ways, with the search box at the top of the window or with the explorer window to the left of
the window. The search bar, highlighted in Red, and the Explorer Window, highlighted in Green
are shown in the image below. Create a New Model, click on the New Model Button. The New



Model button is located in the top left of the Simulink Library Browser window. The New Model
button, highlighted in Blue in Figure 2, is shown below.
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Figure 2: Simulink Library Browser

4. After the New Model window opens up, click on the Simulink Library Browser window. In the
Library Browser, look at the Libraries window on the left. Scroll down until the PLECS Library
appears. Click on the PLECS library, Drag and Drop the Circuit component into the New Model
Window. In the Model window, double click on the PLECS Circuit name “Circuit” and change
the name to “Part 1”.
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Figure 3: Simulink Library Browser - PLECS Library

Part #1
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Figure 4: PLECS Circuit 1 in Simulink Model

5. Double click on the PLECS Circuit component. A new window with a tan background will pop
up, the PLECS window. In this window hit Ctrl+L, that shortcut will bring up the Library Browser.
In the library browse to the Electrical->Sources section. Drag and Drop a Voltage Source
(Controlled) into the PLECS window. Next browse to the Electrical->Meters section, drag and
drop two Voltmeters into the PLECS window. Next browse to the Electrical->Power
Semiconductors section, Drag and Drop one Diode into the PLECS window. Then browse to the
Control->Sources section and place a Ramp function. To place the last component, browse to the
System section, Drag and Drop a Scope into the PLECS window.




Component Overview:

Ramp: This component is a control component. It is used to supply control signals to a variety
of components. For this lab, the ramp will have a slope of 1/second, an initial output of -10,
and a final output of 10. To change the parameters, double click on the component block in the
PLECS window and change the necessary values.

Voltage Source (Controlled): This component outputs a controlled voltage. The control signal
is fed through the green input on the component. For this lab the control signal will be from
the Ramp component. The ramp will vary from -10 volts to +10 volts over 20 seconds. By
varying the voltage supplied by the source, the circuit will be DC swept.

Scope: This component will be used to display the output from the voltmeters. For this part of
the lab the scope will need two plots. To change the number of plots, double click on the scope
block, then select File->Scope Parameters. In the Scope Parameters window, check to make
sure the Number of Plots is Two. Before clicking ok, verify the Limit Samples box is not
checked.

Voltmeter: This component functions like a digital multi meter in lab. The voltmeter is attached
across one or many components in the circuit and outputs the measured voltage. The output
from the meter is accessed through the green arrow on the component. For this lab the output
of the voltmeter will go into the Scope.

Diode: This component simulates the behavior of a Diode in a circuit. For this part of the lab,
you are using one diode. Change the parameters of the diode to the following. The forward
voltage, VT, should be set to 0.7V and the On-resistance, Ron, should be set to 0.001Q. To
change the parameters of the component, double click the logo, change the two parameters in
the window that pops up, and then click ok.

Resistor: This component simulates the behavior of a resistor in a circuit. For this part of the
lab, set the resistance to 1Q.

6. After changing the parameters of the components, connect the components to form the circuit
shown below. To connect two components, click and drag from the dot at the end of one
component to the end of the other component.
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Figure 5: PLECS Circuit 1



7. Now that the circuit has been constructed, the simulation parameters need to be set. To set the
simulation parameters, click on the PLECS window and browse to Simulation->Simulink
Parameters, or hit Ctrl+E.

Simulation Parameters:

Start Time: 0 Seconds

End Time: 20 Seconds

Max Step Size: le-4

8. Run the simulation, browse to Simulation->Start or hit Ctrl+T.

The Lab Report should list the steps, components used with the corresponding values, and include
a Sketch of the PLECS schematic and Scope plots.

Q1: What is the current through the diode at 1.0V? At 0.02V?
Q2: At what voltage does the current begin to increase very quickly?
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Figure 6: PLECS Circuit 1 and 2 in Simulink Model

9. For the next part of the lab, go back to the Model in Simulink, place a new PLECS Circuit in
the Model. Rename the New PLECS block Part 2. Open the new PLECS block, in this PLECS
block create the same circuit as part 1 with two changes, an additional resistor and change the
Voltage Source (Controlled) to an AC Source. The resistor should be set to 1.0kQ. Change the AC
Source Amplitude to 10 and the frequency to 2*pi*60. Connect the voltage probe across the
resistor instead of across the diode. Simulate the model and record the simulated waveform.
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Figure 7: PLECS Circuit 2

The Lab Report should list all steps; give a table of the simulation values for all components and
the corresponding initial conditions. Also include a printout of the PLECS schematic and results
generated after simulation.

Simulation Parameters:
Start Time: 0 Seconds
End Time: 0.05 Seconds
Max Step Size: le-4

Q3: Explain why the output signal is different from the input signal.
Q4: Sketch the output signal that would result if the diode direction were reversed.



Part #3
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Figure 8: PLECS Circuit 1-3 on Simulink Model

10. Create the circuit shown in figure 9 in a new PLECS block. The circuit involves one Resistor
and Capacitor in parallel. Set the resistor to 1.0kQ and the capacitor to 3 mF (milli-Farad). Inside
the PLECS block, place a voltage probe across the capacitor. Set the initial value of the on the
capacitor to OV. Simulate the model and record the simulated waveform.
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Figure 9: PLECS Circuit 3

The Lab Report should list all steps; give a table of the simulation values for all components and
the corresponding initial conditions. Also include a printout of the PLECS schematic and results
generated after simulation.

Q5: By comparing these results to those in step 2, what effect did the capacitor have on the
output signal?



Part #4
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Figure 10: PLECS Circuit 1-4 on Simulink Model

11. Create the circuit shown in figure 11 in a new PLECS block. The circuit for part 4 is a full-
wave rectifier. Each of the diodes will need to have a Forward voltage of 0.7V and an On-resistance
of 0.1Q. After building the full-wave rectifier, add a 1Q load resistor across the output of the full-
wave rectifier. Place a volt meter across the AC source and the load resistor. Simulate the model
and record the simulated waveform.
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Figure 11: PLECS Circuit 4

The Lab Report should list the steps and include a printout of the PSPICE schematic and the
transient response.

Q6: By comparing these results to those in step 2, what effect did the added diodes have on the
output signal?



Part #5
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Figure 12: PLECS Circuit 1-5 on Simulink Model

11. Create the same circuit from Part #4. Add a capacitor in parallel with the load resistor. Set the
capacitor to a value of 0.05F. Set the initial voltage to OV. Simulate the model and record the

simulated waveform.
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Figure 13: PLECS Circuit 5

The Lab Report should list the steps and include a printout of the PSPICE schematic and the
transient response.

Q7: Compare these results to those seen in Part #3.

Technical Memorandum:
A Technical Memorandum is required for this laboratory experiment.
Memorandum Discussion:

(1) What is the current through the diode of figure 5 at 1.0V? Compare the value to the theoretical
values.
(2) Compare the output of figure 7 and figure 11. What were the advantages and disadvantages
of each circuit?
(3) When building a rectifier circuit, what are the two primary forces that compete when designing
the rectifier?

Appendix:
Appendix 1: Sketch the output of Figure 7 if the diode were reversed
Appendix 2: Sketch the output of Figure 7 if a capacitor were add in parallel with the resistor





